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ABSTRACT 

 

Automobile parts one of the major important part is a wheel spoke because of all of the automobile parts carried 

by spokes. Heavy load carrying vehicles having high strength and good fatigue property spoke. In this work 

new spoke is designed and from five spokes to four spokes and comparing of these spokes by using new 4 

aluminum composite materials LM 25, LM25TB7, LM 25TE, LM25TF. Comparing properties of stress and 

displacement with Magnesium Alloy (AM 60A). Model is developped in Unigraphics and analysis done in 

cosmos software. Finally absorbing in my project compare to all material what are the material using in this 

project the aluminum composite material LM25TF was good fatigue life, low stress and high displacement. 

Keywords : LM 25, LM25TB7, LM 25TE, LM25TF 

 

I. INTRODUCTION 

 

The wheel is a device that enables efficient 

movement of an object across a surface where there is 

a force pressing the object to the surface. Early 

wheels were simple wooden disks with a hole for the 

axle. Because of the structure of wood a horizontal 

slice of a trunk is not suitable, as it does not have the 

structural strength to support weight without 

collapsing; rounded pieces of longitudinal boards are 

required. The spoke wheel was invented more 

recently, and allowed the construction of lighter and 

swifter vehicles. Alloy wheels are automobile wheels 

which are made from an alloy of aluminum or 

magnesium metals (or sometimes a mixture of both). 

Alloy wheels differ from normal steel wheels because 

of their lighter weight, which improves the steering 

and the speed of the car, however some alloy wheels 

are heavier than the equivalent size steel wheel. 

Alloy wheels are also better heat conductors than 

steel wheels, improving heat dissipation from the 

brakes, which reduces the chance of brake failure in 

more demanding driving conditions. Over the years, 

achieving success in mechanical design has been 

made possible only after years of experience coupled 

with rigorous field-testing. Recently the procedures 

have significantly improved with the emergence of 

innovative method on experimental and analytical 

analysis. Alloy wheels intended for normal use on 

passenger cars have to pass three tests before going 

into production: the dynamic cornering fatigue test, 

the dynamic radial fatigue test, and the impact test. 

Many alloy wheels manufacturing company had done 

numerous amount of testing of their product but 

their method on simulation test on alloy wheel 

information often kept limited. 
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Wheel Rim Nomenclature  

 
Fig 1. Wheel Rim Nomenclature 

Hub: This forms the interface between the hub of the 

vehicle’s drive train and the wheel. This part will 

have the bolt holes to facilitate in the fastening of the 

wheel to the vehicle. 

Wheel disc or spokes: This is the part of the wheel 

that transfers all of the loads. 

Rim flange or lips: These lips retain the tire and also 

act as a strength-rib to protect the wheel against 

impact loads. 

Bead seat: The tire bead will rest against this area. 

Humps: These humps will ensure that the tire stays 

against the rim flange in the deflated condition. 

Rim well: This area facilitates in the assembling and 

disassembling of the tire. 

 

The rim of a wheel is the outer circular design of the 

metal on which the inside edge of the tyre is 

mounted on vehicles such as automobiles. For 

example, in a two wheeler the rim is a hoop attached 

to the outer ends of the spokes-arm of the wheel that 

holds the tyre and tube. 

 

Better heat conduction can help dissipate heat from 

the brakes , which improves braking performance in 

more demanding driving conditions and reduces the 

chance of brake failure due to overheating. 

 

Wheel rim is the part of automotive where it heavily 

undergoes both static loads as well as fatigue loads as 

wheel rim travels different road profile. It develops 

heavy stresses in rim so we have to find the critical 

stress point and we have to find for how many 

number cycle that the wheel rim is going to fail. 

 

Shape of Rim 

Typical rim shape vehicles are made up of the 

following three types. 

 

Drop Center Rim (DC) 

Drop Center Rim (DC Rim) is shaped so there is a 

well between the bead seat part which is located on 

both sides of the rim. This well is to make the 

mounting and dismounting of the tire easy. In most 

cases there is a taper of 5 degrees in the bead seat area. 

 

Wide Drop Center Rim (WDC) 

Wide Drop Center Rim (WDC Rim) is basically the 

same as DC Rim. To expand the width of the rim, 

with a shallower well and a lower flange height, this 

rim is mainly applied to low aspect ratio tires. This 

design is currently applied to rims for tires of most 

passenger vehicles. 

 

Wide Drop Center Rim with hump (WDC) 

In addition, this design has a bump, which is called a 

hump, on the beginning of the bead seat area. This 

hump is to prevent the bead slipping down and air 

leakage from the rim due to the horizontal force 

applied to the tire when a vehicle tubeless tires turns 

at high speed. 

http://en.wikipedia.org/wiki/Brakes
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Fid 2. Shapes of Wide Drop Center Rim, with Hump 

 

Wheel Material: 

Magnesium Alloy 

Chemical Composition limits of AM60A [9] 

 
Mechanical Properties 

 Name : Magnesium alloy AM60A  

 Yield strength : 130 N/mm2 

 Elastic modulus : 45000 N/mm2 

 Poisson's ratio : 0.35  

 Mass density : 1.8 gm/CC 

 

Aluminum Alloys 

Chemical Composition limits of LM 25 [18] 

Mechanical Properties 

 
 

 

HEAT TREATMENT 

➢ LM25-TE (Precipitation treated) - Heat for 8-12 

hours at 155- 175oC and allow to cool in air 

➢ LM25-TB7 (Solution treated and stabilized)-heat 

for 4-12 hours at 525-545oC and quench in hot 

water, followed by a stabilizing treatment at 

250oC for 2-4 hours. 

➢ LM25-TF (Fully heat treated)- heat for 4-12 

hours at 525- 545oC and quench in hot water, 

followed by a precipitation treatment of 8-12 

hours at 155-175OC. 

 

Effects of Alloying Elements[26] 

 

The Aluminum Association’s Designations and 

Chemical Composition Limits for Aluminum Alloys 

in the Form of Castings and Ingot lists for each alloy 

10 specific alloying elements and also has a column 

for “others”. Not all of the listed elements are major 

alloying ingredients in terms of an alloys intended 

uses; and some major elements in one alloy are not 

major elements in another. Also, some elements, like 

Sr for example, can be very important to 

microstructure control and mechanical properties but 

are not specifically identified in the Aluminum 

Association document and are instead are merely 

included in the category “others”. For purposes of 

understanding their effects and importance, alloying 

elements for the majority of alloys are probably best 

classified as major, minor, microstructure modifiers 

or impurities; understanding, however, that impurity 

elements in some alloys might be major elements in 

others: 

 

• Major elements typically include silicon (Si), 

copper (Cu) and magnesium (Mg) 

• Minor elements include nickel (Ni) and tin (Sn) -

- found largely in alloys that likely would not be 

used in high integrity die castings. 
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Major Elements 

Silicon: Silicon (Si) is unquestionably the most 

important single alloying ingredient in the vast 

majority of aluminum casting alloys. Silicon is 

primarily responsible for so-called “good castability”; 

i.e., the ability to readily fill dies and to solidify 

castings with no hot tearing or hot cracking issues. 

Silicon’s important role as an alloying ingredient is 

several-fold: 

• Silicon’s high heat of fusion contributes 

immensely to an alloy’s “fluidity” or “fluid life”. 

• The fact that silicon has limited solid solubility 

(maximum 1.65%) and yet forms a eutectic with 

aluminum at a significantly high level (12%) 

means that alloys with more than a few percent 

silicon undergo a relatively large volume fraction 

of isothermal solidification, thus they gain 

significant strength while undergoing little or no 

thermal contraction - very important to avoiding 

hot tearing or hot cracking issues. 

• The more silicon an alloy contains, the lower is 

its thermal expansion coefficient. 

• Silicon is a very hard phase, thus it contributes 

significantly to an alloys wear resistance. 

• Silicon combines with other elements to improve 

an alloy’s strength and to make alloys heat 

treatable. 

• Silicon can cause a permanent increase in a 

casting’s dimensions (termed “growth”) if the part 

is not thermally stabilized before being put into 

elevated temperature service. 

Copper: Copper (Cu) has the single greatest impact of 

all alloying elements on the strength and hardness of 

aluminum casting alloys, both heat-treated and not 

heat-treated and at both ambient and elevated service 

temperatures. Copper also improves the 

machinability of alloys by increasing matrix hardness, 

making it easier to generate small cutting chips and 

fine machined finishes.On the downside, copper 

generally reduces the corrosion resistance of 

aluminum; and, in certain alloys and tempers, it 

increases stress corrosion susceptibility.  

 

Aluminum-copper alloys that do not also contain at 

least moderate amounts of silicon have relatively 

poor fluidity and resistance to hot tearing during 

solidification. Although alloys with up to 10% copper 

were popular in the very early years of the aluminum 

foundry industry, they have now been replaced by 

silicon containing alloys, with the exception of the 

very-high-strength alloy 206 that is described later. 

Magnesium: Magnesium’s (Mg) role is also to 

strengthen and harden aluminum castings. As 

mentioned earlier in this section, silicon combines 

with magnesium to form the hardening phase, Mg2Si 

that provides the strengthening and heat treatment 

basis for the popular 356 family of alloys. Magnesium 

is also the strengthening ingredient in the high 

magnesium 5XX alloys that contain very little silicon; 

those alloys too depend on Mg2Si, but gain 

additionally from other magnesium-bearing phase. 

Minor Elements 

Nickel: Nickel (Ni) enhances the elevated 

temperature service strength and hardness of 2XX 

alloys. It is employed for the same purpose in some 

3XX alloys, but its effectiveness in the silicon-

containing alloys is less dramatic. 

Tin: Tin (Sn) in 8XX aluminum casting alloys is for 

the purpose of reducing friction in bearing and 

bushing applications. The tin phase in those alloys 

melts at a very low temperature (227.7 C). Tin can 

exudes under emergency conditions to provide short-

term liquid lubrication to rubbing surfaces if such 

bearings/bushings severely overheat in service. The 

8XX series alloys are not generally applicable to die 

casting or its variations and thus are not shown 

among the alloys suitable for high integrity die 

casting. 

 

Tests conducted on Wheel[22] 

Wheels are part of a vehicle and as such subjected to 

a high load. The durability of the wheel is important 
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for the safe operation of the vehicle. Therefore, it is 

necessary to examine a wheel for both strength and 

fatigue resistance. 

a. Endurance Test in Direction of Radius of Rim 

The tire on the test rim is rotated under high 

pressure condition on steel drum and the 

durability of the rim is examined. Sometimes, test 

is done giving camber angle and adding a side 

force. 

b. Test of Disc 

The rim flange is tested by applying a load from 

an arm mounted to the hub. A bending moment 

is applied while the rim rotates. 

c. Impact Test 

The case where the wheel collides with curb of 

the road or a large obstacle is assumed and the fall 

impact examination is done. 

d. Others 

The test for welding between rim and disc and 

the nut seat tightening etc. are provided in the 

vehicle test standard. Moreover, nondestructive 

testing such as X ray and color check, etc. are 

adopted to the light alloy wheel to detect the 

defects in the casting process. Bead Unseating 

Test, provided in the tire safety standards, for a 

mounted tire and the rim is also applied. In 

addition tests are carried out in the field with the 

assembly mounted on a vehicle under various 

road surfaces. 

 

Limiting period of Wheel 

 

Though we think it is possible to permanently use a 

wheel until it rusts away there is a limit to a wheels 

useful life. If a rim is used in severe operations such 

as racing or rallying hidden damage is caused. This 

may result in an accident or sudden rim failure whilst 

damage is caused. This may result in an accident or 

sudden rim failure whilst the vehicle is in service. 

The life of a rim is varied according to using 

conditions. A rim normally lasts longer than a tire so 

at time of a tire change a rim should be checked for 

damage or sign of failure. If any are found the rim 

should be scrapped. In the case of steel wheel, cracks 

and corrosions by rust at the joint parts of rim and 

disc, nut seats, between decoration holes of the rim 

or the flange is bent, you should scrap the rim. 

 

Maintaining rims     

Very necessary but often overlooked, it is vitally 

important to inspect your motorcycle rims and clean 

them on a regular basis to help prevent spoke failure 

or corrosion weak points. You can definitely suffer 

flat tires if a few spokes fail on your motorcycle rims. 

This can happen under ordinary everyday conditions. 

The broken spoke pushes into the wheel and 

punctures the tube. So always keep your wheels clean 

and check them for signs of corrosion or other 

damage. It may only take one bad spoke to ruin your 

ride. The aluminum motorcycle rims are usually 

coated. Some chemicals used for bike maintenance of 

other systems (like brake fluid) can damage that 

coating. Once the bare aluminum on the motorcycle 

rim is exposed to air it can begin to corrode. Wheels 

can come under a lot of stress and even small areas of 

corrosion can become a point of failure. 

 

Rim locks are used on wheels to prevent your tire 

from slipping around your motorcycle rims. This can 

occur if you are running your tires at very low 

pressures. They are quite common when bikers take 

to riding off road. If your tire turns on the rim it can 

pull the valve stem through the wheel or tear it off 

completely leaving you with a flat. They are fairly 

simple to install but it requires removal of the tires 

and tubes and this can be more work than the rim 

lock installation. The rear is the more critical of the 

motorcycle rims to lock as it is subjected to the forces 

of driving the bike forward. Install them opposite the 

valve stem to minimize the affect they will have on 

wheel balance. 
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Failure of a Wheel rim 

Motorcycle Rim Problems 

 

If we have been in an accident or purchased a bike 

with unknown history it is possible that your 

motorcycle wheel could be out of true. The wheel 

might seem to oscillate laterally (side to side) or 

appear to move up and down (out of round). 

Motorcycle rims can be casually inspected by 

supporting the bike on the centre stand or other 

stand and spinning them while viewing side on or 

edgewise. A really bad wobble will be obvious even 

to someone like us. We can secure a sharp pencil to 

the fork or swing arm to help measure smaller 

variations. If the wheel is badly out of true, especially 

if the cause is from an accident, we may want to let a 

professional motorcycle rims shop or dealer do the 

repair. Sometimes the cause is just from lazy spoke 

maintenance. The wheel can slowly drift out of true 

over time. This kind of thing can be repaired ourself 

if we are up to it.  

 

New Tire, new wobble 

If you have just had new tires installed and you feel 

or see a wobble it is more likely that the tire is the 

cause not bent rims. What can happen when 

mounting a new tire is the installer fails to get the 

new tire fully seated on the motorcycle rims. It may 

be close and because the tire has a tube in it there 

will be no leak to give it away. What you need to do 

is this.  

▪ Examine the sidewall of the tire where it meets 

the rim to see if there is any indication that the 

tire is not fully seated. This might show up as a 

slight variation in the measurement between a 

mould line on the tire and the rims. This is best 

done on a centre stand if you have one.  

▪ Have the installer correct any problem you find. 

Sometimes stock rims can be difficult to seat 

properly (or unseat for that matter).  

▪ Sometimes what the tire installer will do to 

correct the problem is overinflate the tire to 

force the tire to seat. I am not suggesting you 

try this yourself, it can be very dangerous.  

▪ Also make sure the tire is installed correctly, 

arrow pointing in the direction of travel.  

 

II. INTRODUCTION SOFTWARES 

 

INTRODUCTION OF CAD/CAM 

Engineering drawings have been in use for more than 

2000 years. However, the use of orthographic 

projections was formally introduced by the French 

mathematician Gaspard Monge in the eighteenth 

century. 

 

Since visual objects transcend languages, engineering 

drawings have evolved and become popular over the 

years. While earlier engineering drawings were 

handmade, studies have shown that engineering 

designs are quite complicated. A solution to many 

engineering problems requires a combination of 

organization, analysis, problem solving principles and 

a graphical representation of the problem. Objects in 

engineering are represented by a technical drawing 

(also called as drafting) that represents designs and 

specifications of the physical object and data 

relationships. Since a technical drawing is precise and 

communicates all information of the object clearly, it 

has to be precise. This is where CAD comes to the 

fore. When it was introduced first, CAD was not 

exactly an economic proposition because the 

machines at those times were very costly. The 

increasing computer power in the later part of the 

twentieth century, with the arrival of minicomputer 

and subsequently the microprocessor, has allowed 

engineers to use CAD files that are an accurate 

representation of the dimensions / properties of the 

object. 

 

UNIGRAPHICS 

NX is one of the world’s most advanced and tightly 

integrated CAD/CAM/CAE product development 

solutions. Spanning the entire range of product 
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development, NX delivers immense value to 

enterprises of all sizes. It simplifies complex product 

designs, thus speeding up the process of introducing 

products to the market. 

 

The NX software integrates knowledge based 

principles, industrial design, geometric modeling, 

advanced analysis, graphic simulation, and 

concurrent engineering. The software has powerful 

hybrid modeling capabilities by integrating 

constraint based feature modeling and explicit 

geometric modeling. In addition to modeling 

standard geometry parts, it allows the user to design 

complex free form shapes such as airfoils and 

manifolds. It also merges solid and surface modeling 

techniques into one powerful tool set.  

 

NX design tools are superior in power, versatility and 

productivity. You can work faster and more 

efficiently in the full range of design tasks, from 2D 

layout through 3D modeling, assembly design, 

drafting and documentation. Work Seamlessly with 

Data from Other CAD Systems • With synchronous 

technology, NX allows you to directly use models 

created with other CAD systems. You can import and 

modify CAD geometry from any source with speed, 

ease and efficiency. NX is the solution of choice for 

multi-CAD, collaborative design. 

 

III. MODELING OF ALLOY WHEEL 

 

Entering In to Modelling : 

Steps to be considered for Modelling of Alloy wheel : 

• Selection of Datum Plane 

• Selection of Curves 

• Procedure of Revolve 

• Extruding procedure 

• Combing of features in to a single entity 

• Procedure of hole 

• Blend Process 

• Drafting 

 

First Start up procedure of Unigraphics 

 

➢ To start Unigraphics, Go to Windows Button and 

select the nx9.0 icon. 

➢ Then the User Window will open. 

➢ Select the model filter to draw the 3d model.  

 

 
 

Selection of datum plane 

 

➢ After entering into the model. 

➢ Select the datum plane from draw group with 

respective datum co ordinate system 

 
Sketch Environment: 

➢ To Draw a Sketch, we need to select the 

environment. 
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➢ By selecting the environment we will enter 

into the drawing plane which was in 2d  

Selection of Curves: 

➢ To draw a curve, select the required curve 

from the draw group. 

 

 
➢ Draw a circle and fully constrained it with 

the help of Geometrical and dimensional 

Constraints . 

EXTRUDE Process : 

➢ To Extrude a Sketch we need to select the 

sketch. 

➢ Then Click on the Extrude Command  

➢ New Window will appears  

➢ It will contain some required processes we 

have to fill the requirements. 

➢ Make sure the direction is in our required 

position. 

 
Revolve Process: 

➢ After Extrusion process. We have to draw a 

revolving feature which supports the tire. 

➢ To that process we have to draw a sketch. 

➢ For revolving a Sketch we need to set the 

vector and plane direction. 

 
➢ While Revolving the feature dimensions need 

to be checked clearly 

Color Assigning: 

➢  For my better Appearance I used black color. 

Changing procedure is 

➢ 

Select the feature and go to menu > insert > 

assign color 

➢ Select the required color. 

 

Sketching Alloy Spoke : 

 
➢ For Alloy Spoke we have to use extra 

command  

➢ Blend Command is used for spoke 

➢ Procedure: Draw sketch with dimensionally  
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  Extrude the sketch 

 Apply blend on edges 

 Variational blends are used in this spoke  

 

Pattern Geometry : 

➢  Pattern Geometry is used to place the copied 

features in a circular manner. 

➢  Procedure: Select the feature 

 

Go to > Insert > Associate copy>pattern geometry 

Axis has to be selected  

Number of entities  

Angle of entities has to be mentioned  

 
Combining of Features: 

➢ For Combining, We use Unite Command. 

➢ Procedure :  

Go to > Modify Command > Unite  

Select the target body  

Select the base body  

Both the features will combine. 

 

 
Procedure for hole : 

➢ Select the face of the entity 

➢ Select the center of the circular object  

➢ Go to > Operations group > hole  

➢ Select the type of hole  

➢ Place the dimensions 

➢ Diameter and depth should be given 

 
Same procedure for 4 wheel alloy also 

 
 

Drafting : 

The Drafting Model is a part of a complex 

information model describing product definition data, 

their applications and their representations. The 

definition of the information model is a central 

component of the development of STEP, a future 

international standard for the exchange of product 

defamation data. Here the Drafting Model 

particularly encloses descriptions for the 

representations of organizational drawing data, 

tolerances, dimensions and surface attributes such as 

surface finish symbols (a survey of the whole content 

is shown in the figure above).  

 
Introduction to COSMOS 
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Using the COSMOS Program  

Cosmos is a feature-rich control and configuration 

software for the Avitech line of products. It uses a 

GUI (graphical user interface) for configuring and 

editing complex Multiviewer systems. Preset 

configurations can be created, edited, are called. 

Cosmos is designed to interface with third-party 

hardware such a routing switchers, production 

switchers, and Tally management systems allowing 

for dynamic label changes and Tally indicators on the 

display. The program contains a built-in alarm and 

fault reporting. When Cosmos is combined with the 

AviNet SNMP option the result is an extremely 

power control solution. Cosmos will run on virtually 

any computer, running the windows operating 

system. 

 

SolidWorks Simulation Xpress is design analysis 

software that is fully integrated in SolidWorks. 

SolidWorks Simulation Xpress simulates the testing 

of your part’s prototype in its working environment. 

It can help you answer questions like: how safe, 

efficient, and economical is your design. 

 

SolidWorks Simulation Xpress is used by students, 

designers, analysts, engineers, and other professionals 

to produce safe, efficient, and economical designs. 

 

Feature 

➢ Add modules or groups while the system is 

online.  

➢ Assign audio monitoring on any source.  

➢ Change any window to full screen view with 

a single click of a but 

➢ Configure Avitech’s GPI interface. Control 

third-party routers, integration with multiple 

third-party router control systems.  

➢ Create analog or digital clocks with ability to 

countdown/count up timer.  

➢ Customize labels, borders, background colors, 

and fonts (color and 

➢ Make changes to the entire border or for each 

individual window.  

System requirements for COSMOS 

The following are the system requirements to ensure 

smooth running of COSMOS SOFTWARE. 

 

System unit: An inlet® core™ i3-2600 CPU @ 

3.40GHz based workstation running Microsoft 2009 

corporation windows7 ultimate or home basic 

professional edition. 

Memory: 12.0 GB of RAM is minimum 

recommended for all application. 

Disk drive: 100 GB disk drive space (minimum 

recommended size) 

Internal /external drives: A CD-ROM drive is 

required for program installation. 

Display: A graphic colour display compatible with 

the selected platform – specific graphic adapter. The 

minimum recommended monitors size 17 inches. 

Graphics adapter: A graphics adapter with a 3D 

OpenGL accelerator is required with minimum 

resolution of 1024× 768 for Microsoft windows 

workstations and 1280×1024 for UNIX workstations. 

 

Description of Commands used in COSMOS[30]  

Using the Interface 

Starting a Program 

1 Click the Start button in the lower left corner of 

the window. The Start menu appears. The Start menu 

allows you to select the basic functions of the 

Microsoft Windows environment. 

2 From the Start menu, click Programs, SolidWorks, 

SolidWorks as shown below. 

The SolidWorks application program is now running. 

 

Exit the Program 

To exit the application program, click File, Exit or 

click on the main SolidWorks window. 
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SolidWorks Windows 

SolidWorks windows have two panels. One panel 

provides non-graphic data. The other panel provides 

graphic representation of the part, assembly, or 

drawing. The leftmost panel of the window contains 

the FeatureManager® design tree, PropertyManager 

and ConfigurationManager. 

1. Click each of the tabs at the top of the left panel 

and see how the contents of the window changes. 

The rightmost panel is the Graphics Area, where 

you create and manipulate the part, assembly, or 

drawing. 

2. Look at the Graphics Area. See how the alloy 

wheel is represented. It appears shaded, in color 

and in an isometric view. These are some of the 

ways in which the model can be represented very 

realistically. 

 

Toolbars 

Toolbar buttons are shortcuts for frequently used 

commands. You can set toolbar placement and 

visibility based on the document type (part, assembly, 

or drawing). SolidWorks remembers which toolbars 

to display and where to display them for each 

document type. 

 

1. Click View, Toolbars. 

A list of all toolbars displays. The toolbars with their 

icon depressed or a check mark beside them are 

visible; the toolbars whose icons are not depressed or 

without a check mark are hidden. 

 

2. Turn several toolbars on and off to see the 

commands. 

Mouse Buttons 

Mouse buttons operate in the following ways: 

Left – Selects menu items, entities in the graphics 

area, and objects in the FeatureManager design tree. 

Right – Displays the context-sensitive shortcut 

menus. 

Middle – Rotates, pans, and zooms the view of a part 

or an assembly, and pans in a drawing. 

Stress Analysis: 

SolidWorks Simulation Xpress offers an easy-to-use 

first pass stress analysis tool for SolidWorks users. 

SolidWorks Simulation Xpress can help you reduce 

cost and time-to market by testing your designs on 

the computer instead of expensive and time-

consuming field tests. SolidWorks Simulation Xpress 

uses the same design analysis technology that 

SolidWorks Simulation users to perform stress 

analysis. The wizard interface of SolidWorks 

Simulation Xpress guides you through a five step 

process to specify material, restraints, loads, run the 

analysis, and view the results. 

 

Study on Static Stress Analysis 

To create a static study, click the Simulation tab in 

the upper-left. There should be a button labeled 

“Study Advisor.” Click the arrow just beneath it and 

choose “New Study,” as in Figure. Here you can see 

all the types of studies available in Simulation. Click 

“Static,” name the study something memorable, and 

click the green check mark. 

 

Apply the material, as from the material library given. 

To set up the fixtures on the model, either right-click 

“Fixtures” in the static study pane or click the arrow 

beneath “Fixtures Advisor” in the Simulation tab. 

Choose “Fixed Geometry” as the fixture type for this 

study. 

 

With the pressures and fixtures specified, we can run 

a finite element analysis now! SolidWorks needs to 

break the model into small triangular units, which 

together are called a mesh. Smaller meshes (as in 

meshes with smaller individual units) produce more 

precise results but require additional computing time. 

Large meshes run quickly but may produce wildly 

inaccurate results, especially around sharp edges. It is 

common to use a mesh with varying element sizes: 

smaller units around the areas of interest in a model, 

such as potential failure points, and larger units 

where precise results are less valuable.  
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In the static study pane, right-click “Mesh” and 

choose “Create Mesh.” Accept the default mesh size 

and check OK. This will create a uniformly sized 

mesh over your entire model, which should look 

something like Figure shown. If you ever need a non-

uniform mesh, you can do so by right-clicking “Mesh” 

and choosing “Apply Mesh Control” instead. 

 

Begin the static study by clicking “Run” in the 

Simulation tab. You will see that even this simple 

problem consumes significant memory and time. If 

all goes well, a folder named “Results” will appear in 

the static study pane. Right-click the folder and 

choose “Define Stress Plot,” then accept the default 

settings that appear. 

 

Create a new result plot to show displacement. Right-

click “Results” again and choose “Define 

Displacement Plot.” In the settings pane that appears, 

set “Deformed Shape” to True Scale and check OK. 

By default the displacement is measured in URES 

(“resultant displacement”—U is commonly used to 

abbreviate displacement), which is a simple measure 

of displacement magnitude. Measuring displacement 

along the X, Y, or Z axes is also an option here, 

though we will stick with URES, like in Figure. 

 

Fatigue Analysis 

 During design validation, a structure is exposed to 

both static strength tests and fatigue tests. However, 

once a structure is deployed, it spends the vast 

majority of its lifetime being subjected to smaller 

repeated forces that can cause cumulative damage 

over time. For this reason, testing the durability of a 

structure makes up a larger proportion of the tests 

that are run. Durability is one of the most important 

attributes that structures can posses. 

 

Fatigue testing measures durability and is defined as 

the repeated mechanical loading of a structure to 

determine failure points. It requires complex analysis 

using the field of fracture mechanics, which is the 

analysis of material flaws to discover those that are 

safe and those that are liable to propagate as cracks 

and cause failure. 

 

To create a fatigue study, click the Simulation tab in 

the bottom-left. There should be a Pop-up menu 

labeled as “New simulation study.” Click on it and 

choose “Fatigue” as in Figure. Here you can see all 

the types of studies available in Simulation. Name the 

study something memorable, and click the green 

check mark. 

 

Add an event as constant amplitude for a required 

number of cycles, with zero based condition. Then 

define S-N curve for the applied material, as log-log 

graph. The Stress-Life (S-N) or Total Fatigue Life 

method is widely used for HCF applications. During 

HCF testing, a material spends the majority of life in 

a state where the cracks are very small, the growth is 

controlled, and the structure integrity is retained. As 

noted earlier, the applied stress stays within the 

elastic range of the material. Total Life is determined 

by running multiple specimen tests at a number of 

different stresses. The objective is to identify the 

highest stress that produces a fatigue life beyond 10 

million cycles. This stress is also known as the 

material’s endurance limit. 

 

Begin the fatigue study by clicking “Run” in the 

Simulation tab. You will see that even this simple 

problem consumes significant memory and time. If 

all goes well, a folder named “Results” will appear in 

the fatigue study pane. Right-click the folder and 

choose “Define life Plot,” then accept the default 

settings that appear. 

  

Solid-works Simulation 

Types of analysis: Static Analysis and Fatigue 

Analysis. 

Material Properties: 

Name : Aluminum alloy LM 25 Magnesium alloy 

AM60A  
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Yield strength : 235 N/mm2 130 N/mm2 

Elastic modulus : 71000 N/mm2 45000 N/mm2 

Poisson's ratio : 0.33 0.35  

Mass density : 2.685gm/CC 1.8 gm/CC 

Applied Loads 

Load1 : weight of Bike (168 kg) 

Load2 : (168+50) kg 

Load3 : (168+100) kg  

Load4 : (168+150) kg 

Analysis for strength needed[28] 

Mass of Bike, Dead Weight of Bike =148 Kg 

Other Loads= 20 Kg 

Total Gross Weight= 148 + 20 = 168 Kg 

 168 * 9.81 = 1648.08 N 

Tires and Suspension system reduced by 30% of 

Loads 

Wnet = 1648.08 * 0.7 = 1153.656 N 

Reaction Forces On Bike= FT = 1153.656 N  

Number of Wheels: 2 

Reaction Force on Each Wheel FT =576.828 N  

Number of spokes, N = 5 

Stress on the each Rim = 
FT

Area
 = 0.011945 N/mm2 

Area of rim at stressed parts = 48287.08 mm2  

Stress on the each rim for load1= 0.011945 

N/mm2  

For Different Loads Stress on Each Rim are: 

 With Load2 on Bike (168+50)Kgs 

Total Gross Weight = 218 * 9.81 = 2138.58 N 

Tires and Suspension system reduced by 30% of 

Loads 

Wnet = 2138.58 * 0.7 = 1498.006 N 

Reaction Forces On Bike: FT = 1498.006 N  

Number of Wheels= 2 

Reaction Force on Each Wheel FT =748.503 N  

Number of spokes, N = 5 

Stress on the each Rim = 
FT

Area
 = 0.015501 N/mm2 

Area of rim at stressed parts = 48287.08 mm2  

 

Stress on the each rim for load2= 0.015501 N/mm2 

With Load3 on Bike (168+100)Kg 

Total Gross Weight = 268 * 9.81 = 2629.08 N 

Tires and Suspension system reduced by 30% of 

Loads 

Wnet = 2629.08 * 0.7 = 1840.356 N 

Reaction Forces On Bike: FT = 1840.356 N  

Number of Wheels= 2 

Reaction Force on Each Wheel FT = 920.178 N  

Number of spokes, N = 5 

Stress on the each Rim = 
FT

Area
 = 0.019050 N/mm2 

Area of rim at stressed parts = 48287.08 mm2  

Stress on the each rim for load3 = 0.019050 

N/mm2 

Similarly Load4 Stresses induced on each Rim is 

Stress on the rim for load4= 0.022611 N/mm2 

 

Importing of Alloy Wheel 

Steps to be followed for importing the model from 

Unigraphics 

1. Open the Unigraphics in the computer, select 

the Unigraphics model which has to be 

import into the COSMOS. 

2. Select File-> save a copy->select type as *.igs 

as shown in figure. 

3. Name the file something memorable, and 

click the ok check mark. 

4. Export the model into solid and shells, click 

on ok. 

5. Then the Unigraphics part is saved in the *.igs 

format, which can be opened in the solid 

works for simulation. 

 

Analysis is carried out in COSMOS 

Step 1: Creating a Static Study 

The first step in performing analysis is to create a 

study. 

1. Click Simulation, Study in the main SolidWorks 

menu on the top of the screen. The Study Property 

Manager appears. 

2 Under Name, type Alloy wheel. 

3 Under Type, select Static. 

4 Click . 

Step 2: Assigning Material 
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Assign Alloy of aluminium 

Ilustrates how to Assign the Material 

1. In the SolidWorks Simulation Manager tree, right-

click the Alloy wheel folder and click Apply Material 

to All Bodies. The Material dialog box appears. 

2. Do the following: 

a) Expand the SolidWorks Materials library 

folder. 

b) Expand the Steel category. 

c) Select Alloy of Aluminium required. 

3 Click on Apply and Close. 

Step 3: Applying Fixtures 

You apply fixtures to prevent the out of plane 

rotations and free body motions. 

1. Press spacebar and select Trimetric in the 

Orientation menu. The model orientation is 

as shown in the figure. 

2. In the Simulation study tree, right-click the 

Fixtures folder and click Fixed goemetry. The 

Fixture PropertyManager appears. click the 

green check mark. The fixtures are applied 

and their symbols appear on the selected 

edges. 

Step 4: Applying Pressure 

Apply, 0.011945MPa pressure normal to the 

faces as shown in the figure. 

1. In the SolidWorks Simulation Manager tree, 

right-click the External Loads folder and click 

Pressure. The Pressure PropertyManager 

appears. 

2.  Under Type, select Normal to selected face. 

3.  In the graphics area, select the faces as 

shown in the figure. Face<1> through 

Face<3> appear in the Faces for Pressure list 

box. 

4.  Make sure that Units is set to N/mm^2 

(MPa). 

5.  In the Pressure value box , type 0.011945. 

6.  Click the green check mark. 

SolidWorks Simulation applies the normal pressure to 

the selected faces and Pressure-1 icon appears in the 

External Loads folder. 

 
Ilustrates how to Assign the Pressure 

Step 5: Meshing the Model and Running the Study 

Meshing divides your model into smaller 

pieces called elements. Based on the geometrical 

dimensions of the model SolidWorks Simulation 

suggests a default element size which can be changed 

as needed. 

1.  In the SolidWorks Simulation Manager tree, 

right-click the Mesh icon and select Create 

Mesh. The Mesh Property Manager appears. 

2.  Expand Mesh Parameters by selecting the 

check box. Make sure that standard based 

mesh is selected. 

3. Check Run (solve) the analysis under Options 

and click. 
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Ilustrates how to Meshing the Part model 

Step 6: Creating a Fatigue Study 

The next step in performing analysis is to 

create a fatigue study. 

1.  Click on Alloy wheel option on bottom-left, 

a pop-up menu will generate, choose New Simulation 

Study in the SolidWorks menu on the screen. The 

Study PropertyManager appears. 

2. Under Name, type Alloy wheel fatigue. 

3. Under Type, select Fatigue. 

4. Click the green check mark. 

Step 7: Assigning Event 

1. In the SolidWorks Simulation Manager tree, 

right-click the Loading icon and select Add 

Event option. The Add Event 

PropertyManager appears. 

2. Apply load, as per required number of cycles, 

with option zero based condition as shown in 

the figure. 

3. Define the S-N Curve, as user defined that 

exists in the library. 

Step 8: Run the Fatigue Study 

1. In the SolidWorks Simulation Manager tree, 

right-click the Alloy wheel fatigue icon and select 

Run (or) 

2. Begin the fatigue study by clicking “Run” in 

the Simulation tab. You will see that even this simple 

problem consumes significant memory and time. If 

all goes well, a folder named “Results” will appear in 

the fatigue study pane. 

IV. RESULTS  

Static and Fatigue analysis for 5-spokes Aluminium 

alloy wheel 

 
 

 

 
Mesh report 

Mesh information for Aluminium Alloy wheel-5 

spokes 

Total Nodes 41528 

Total Elements 21498 

 

 
Stress results for 5-spokes Aluminium alloy wheel 
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Displacement results for 5-spokes Aluminium Alloy 

Wheel 

 

Strain result for 5-spokesAluminium Alloy Wheel  

 
Damage percentage result for 5-spokes Aluminium 

Alloy wheel 

 
Total Life (cycle) result for 5-spokes Aluminium 

Alloy wheel 

Fig Shows the max stress 0.000968639 N/mm^2 and 

mini stress 2.35433N/mm^2 that are induced in 5-

Spokes Aluminum Alloy(LM 25 TF). 

Fig 5.2, Shows the max displacement 0.00417283 mm 

and mini displacement 0 mm that are induced in 5-

Spokes Aluminum Alloy(LM 25 TF). 

Fig 5.3, Shows the mini strain 1.07886e-008 and max 

strain 2.20737e-005 that are induced in 5-Spokes 

Aluminum Alloy(LM 25 TF). 

Fig Shows the max fatigue life and mini fatigue 

1e+007 cycle that are induced in 5-Spokes Aluminum 

Alloy(LM 25 TF). 

Shows the max damage and mini damage % is 10 that 

are induced in 5-Spokes Aluminum Alloy(LM 25 TF). 

 Static and Fatigue analysis for 4-spokes Magnesium 

alloy wheel 

 

 
 

 
Mesh report 

Mesh information for Magnesium Alloy wheel 4-

spokes 

Total Nodes 39450 

Total Elements 20063 

 

 
Stress results for 4-spokes Magnesium Alloy Wheel 

 

 



International Journal of Scientific Research in Science and Technology (www.ijsrst.com) 

Darga Shiva Kumar, C. Mohan Naidu   Int J Sci Res Sci Technol. March-April-2019; 6(2) : 32-51 

 

 

 
48 

Displacement results for 4-spokes Magnesium Alloy 

Wheel 

 

Strain results for 4-spokes Magnesium Alloy Wheel 

 

 
Damage percentage results for 4-spokes Magnesium 

Alloy Wheel 

 
Total Life(cycles) results for 4-spokes Magnesium 

Alloy Wheel 

Fig Shows the max stress 0.000775803 N/mm^2 and 

mini stress 2.23756 N/mm^2 that are induced in 4-

Spokes Magnesium Alloy(AM 60A). 

Fig Shows the max displacement 0.00714043 mm and 

mini displacement 0 mm that are induced in 4-

Spokes Magnesium Alloy(AM 60A). 

Fig Shows the max strain 3.5419e-005 and mini strain 

1.40248e-008 that are  

induced in 4-Spokes Magnesium Alloy(AM 

60A). 

Fig 5.9, Shows the max fatigue life and mini fatigue 

1e+008 cycle that are induced in 4- 

Spokes Magnesium Alloy(AM 60A). 

Fig 5.10, Shows the max damage and mini damage % 

is 1 that are induced in 4-Spokes  

Magnesium Alloy(AM 60A). 

 
Stress Comparsion between 5-Spokes and 4-Spokes 

alloy wheel of Aluminum Alloy (LM 25). 

Fig indicates Stresses induced in the 4-Spokes alloy 

wheel as less as compared with the Stress induced in 

the 5-Spokes alloy wheel, for the same Aluminum 

Alloy material (LM 25TF- U.K Standards) by 0.05%. 

 
Stress Comparsion between 5-Spokes and 4-Spokes 

alloy wheel of Magnesium material (AM 60A). 

Figure indicates that, Stresses induced in the 4-

Spokes alloy wheel as less as compared with the 

Stress induced in the 5-Spokes alloy wheel, for 

Magnesium Alloy (AM 60A – ASTM Standards) by 

0.05%. 

 
Illustrates, the Fatigue Life Cycle of 4-Spokes alloy 

wheel of Magnesium and Aluminum material. 
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Illustrates, the Fatigue Life Cycle of 5-Spokes alloy 

wheel of Magnesium and Aluminum material. 

 

The above two graphs indicates that, Fatigue life 

cycle of Magnesium alloy wheel is more as compared 

with the Fatigue life cycle of Aluminum alloy wheel. 

Due to High Strength of Mg-Alloy, Fatigue life is 

more compared with all Al-Alloys. 

VALIDATION 

Stress analysis values for 5-Spokes Mg-alloy and Al-alloys (LM 25, LM 25TB7, LM 25TE, LM 25TF). 

 

5-Spokes 
Aluminum Alloys Magnesium 

alloy (AM60A) LM 25  LM 25TB7 LM 25TE LM 25TF 

LOAD1 1.23366 1.23324 1.23282 1.23250 1.24426 

LOAD2 1.60394 1.60349 1.60290 1.60234 1.61467 

LOAD3 1.97349 1.97290 1.97236 1.97177 1.98441 

LOAD4 2.34366 2.34296 2.34238 2.34163 2.35595 

 

The Stresses induced in the 5-Spokes Aluminum 

Alloy wheel (LM 25TF) 2.34163MPa is less as 

compared with the Stresses induced in the 5-Spokes 

Magnesium alloy (AM60A), Al-alloys (LM 25, LM 

25TB7, LM25TE) wheels. 

 

Table 5.2: Stress analysis values for 4-Spokes Mg-

alloy and Al-alloys(LM 25, LM 25TB7, LM 25TE, LM 

25TF). 

 

4-

Spokes 

Aluminum Alloys Magnesium 

alloy 

(AM60A) LM 25  
LM 

25TB7 

LM 

25TE 

LM 

25TF 

LOAD1 1.16996 1.16961 1.16923 1.16881 1.18167 

LOAD2 1.52037 1.51989 1.51938 1.51887 1.53389 

LOAD3 1.87069 1.87016 1.86966 1.86912 1.88506 

LOAD4 2.22184 2.22134 2.22802 2.22029 2.23756 

 

The Stresses induced in the 5-Spokes Aluminum 

Alloy wheel (LM 25TF) 2.22029 MPa is less as 

compared with the Stresses induced in the 5-Spokes 

Magnesium alloy (AM60A), Al-alloys (LM 25, LM 

25TB7, LM25TE) wheels. 

 

Table 5.3: Fatigue Life values for 5-Spokes and 4-

Spokes Mg-alloy and Al-alloys(LM 25, LM 25TB7, 

LM 25TE, LM 25TF). 

 

5-

Spokes 

and            

4-

Spokes 

Magnesium 

alloy 

(AM60A) 

Aluminum Alloys 

LM 

25 

LM 

25TB7 

LM 

25TE 

LM 

25TF 

LOAD1 1.0E8 1.2E7 5.0E6 5.0E6 1.0E7 

LOAD2 1.0E8 1.2E7 5.0E6 5.0E6 1.0E7 

LOAD3 1.0E8 1.2E7 5.0E6 5.0E6 1.0E7 

LOAD4 1.0E8 1.2E7 5.0E6 5.0E6 1.0E7 

 

Due to High Strength and Hardness of Mg-Alloy, 

Fatigue life is more compared with all Al-Alloys. 

Stress analysis values for 4-Spokes Mg-alloy(AM 60A) 

and Al-alloys(LM 25) with different Fillet radii. 

 

4-Spokes 

Aluminum alloy 

(LM 25TF) with 

Fillet 8 mm 

Aluminum Alloy 

(LM 25TF) with 

Fillet 9mm 

LOAD1 1.16881 1.16252 

LOAD2 1.51887 1.51193 

LOAD3 1.86912 1.86125 

LOAD4 2.22029 2.21029 
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The Stresses induced in the 4-Spokes Aluminum 

Alloy wheel (LM 25TF) 2.21029 MPa is less as 

compared with the Stresses induced in the 4-Spokes 

Aluminum Alloy (LM25TF) wheels. 

 

Aluminum Alloy (LM25) is utilized for the validation 

of this thesis from Deepak (2012)[25]. Due to 

different Heat Treatment conditions, Aluminum 

Alloys obtained are LM 25TB7, LM 25TE and LM 

25TF. Analysis is done on the three different Al-

alloys and also on an existing material of the 

Magnesium alloy (AM 60A). 

 

The stresses obtained in the three different alloys are 

less as compared with the LM25, because if a material 

is heated to high temperature followed by quenching 

in hot water or rapid cooling,  

1. Larger grains will break into small grains. 

2. Hardness and Strength increases, due to Ionic 

bond between the molecules. 

But the Stresses obtained in the Magnesium Alloy 

(AM 60A) is more as compare with all the three 

Aluminum Alloys, because an HCP structure exists in  

magnesium which makes magnesium more brittle 

because of their few active slip systems. Also 

magnesium is highly active in presence of Oxygen 

forming magnesium oxide and an improvement  is 

needed in heat dissipation and micronization of 

Crystal grains of magnesium. Due to all these, the 

stresses obtained in Mg-alloy are more as compared 

with all Al-Alloys. 

 

IV. CONCLUSION 

 

An Al-Alloy Wheel was modeled using Unigraphics 

of two Spokes i.e., 4 and 5 with  fillet radii (8mm and 

9mm). These models were analyzed using COSMOS 

for five different materials, LM 25, LM25TB7, LM 

25TE, LM25TF and AM60A. 

From the results obtained it may be concluded that 

1. The analysis results showed that the 

maximum stress area was located at Spoke-

Rim contact. Stresses induced in 4-Spokes 

Aluminum Alloy (LM 25TF) are less as 

compared with Magnesium Alloy (AM 60A) 

and all the three Aluminum Alloys of 4 and 5 

Spokes. 

2. Fatigue life cycle is estimated based on the 

Equivalent Stresses induced on Al-alloys and 

Mg-alloy materials. Fatigue life cycle for the 

Mg-alloy is more as compared with all Al-

alloys materials. 

3. Re-model of alloy wheel, from 5-Spokes to 4-

Spokes, along with small change in Fillet 

radius from 8 mm to 9 mm, at Rim-Spoke 

contact. The Stresses induced in Aluminum 

alloy (LM 25TF) are further reduced as 

compared to all the three Al-alloys. 

 

Thus, it is clear that by adding the material at fillet 

edges the stress concentration will be reduced which 

in turn increases the fatigue life of the material and 

material reduction can be done by reducing number 

of Spokes. 

Even though, the Fatigue Life of Magnesium alloy is 

more, by considering all the properties of Aluminum 

alloy like easy availability, recyclable, good heat 

dissipation rate. Aluminum Alloy (LM 25TF) is the 

better material for alloy wheels. 
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